
Georgia Southern University
Digital Commons@Georgia Southern
Georgia International Conference on Information
Literacy

(Formerly known as the Georgia Conference on Information Literacy)

Sep 28th, 8:30 AM - 9:45 AM

Free, Quick & Easy: Utilizing Google Apps to
Assess & Communicate Learning
Josette M. Kubicki
Augusta University, jkubicki@augusta.edu

Thomas Weeks
Augusta University, tweeks@augusta.edu

Jennifer Putnam-Davis
Augusta University, jdavis14@augusta.edu

Follow this and additional works at: https://digitalcommons.georgiasouthern.edu/gaintlit

Part of the Adult and Continuing Education Commons, Curriculum and Instruction Commons,
and the Information Literacy Commons

This presentation (open access) is brought to you for free and open access by the Conferences & Events at Digital Commons@Georgia Southern. It has
been accepted for inclusion in Georgia International Conference on Information Literacy by an authorized administrator of Digital
Commons@Georgia Southern. For more information, please contact digitalcommons@georgiasouthern.edu.

Recommended Citation
Kubicki, Josette M.; Weeks, Thomas; and Putnam-Davis, Jennifer, "Free, Quick & Easy: Utilizing Google Apps to Assess &
Communicate Learning" (2018). Georgia International Conference on Information Literacy. 50.
https://digitalcommons.georgiasouthern.edu/gaintlit/2018/2018/50

https://digitalcommons.georgiasouthern.edu?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
https://digitalcommons.georgiasouthern.edu/gaintlit?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
https://digitalcommons.georgiasouthern.edu/gaintlit?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
https://digitalcommons.georgiasouthern.edu/gaintlit?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
http://network.bepress.com/hgg/discipline/1375?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
http://network.bepress.com/hgg/discipline/786?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
http://network.bepress.com/hgg/discipline/1243?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
https://digitalcommons.georgiasouthern.edu/gaintlit/2018/2018/50?utm_source=digitalcommons.georgiasouthern.edu%2Fgaintlit%2F2018%2F2018%2F50&utm_medium=PDF&utm_campaign=PDFCoverPages
mailto:digitalcommons@georgiasouthern.edu


Ice Breaker Survey!

Thomas Weeks, MLIS
Reference and Instruction Librarian
Reese Library, Augusta University

tinyurl.com/chocbreaker

Josette Kubicki, MLIS, MS
Reference and Instruction Librarian
Reese Library, Augusta University

Jennifer Putnam Davis, MA
Reference Assistant
Reese Library, Augusta University

Presenter
Presentation Notes
Brief Notes: Undertake this quick Ice Breaker Survey to experience one of the Google Apps we use a lot – Google Forms. If you provide an email address associated with a Google account, you can collaborate with us on our second activity.



Free, Quick & Easy

Thomas Weeks, MLIS
Reference and Instruction Librarian
Reese Library, Augusta University

Using Google Apps to Assess and 
Communicate Learning

Josette Kubicki, MLIS, MS
Reference and Instruction Librarian
Reese Library, Augusta University

Jennifer Putnam Davis, MA
Reference Assistant
Reese Library, Augusta University

Presenter
Presentation Notes
Brief Notes: Introduction. Thomas will present the first section, Josette the second, and Josette on behalf of our colleague Jennifer who could no longer make it to the conference.



a caveat…

Presenter
Presentation Notes
Brief Notes: As of just the beginning of this month, September, we are phasing out of using Google Apps for informal assessment and other purposes to using LibWizard by SpringShare. The Libraries’ recently acquired it and we want to use what is supported. But we still like and would recommend Google Apps to other libraries, and we continue to use them for personal use.



Why use Google Apps in the library?

Easily 
shared 

Intuitive and 
easy to use

Easily 
integratedNo cost

Presenter
Presentation Notes
Brief Notes: We have been using Google Apps for informal assessment and other purposes because they are free – the only cost is to keep in mind you are giving your information to Google; easily integrated – you can embed Google Forms into an LMS, LibGuide, and other spaces; intuitive and easy to use - to us, it is more so than LibWizard; and easily shared to be viewed by anyone, and shared for collaboration with those who have a Google Account.



Why use Google Apps in the library?

 No paper

Using Google Forms for Assessment

 Easy to edit

 Easy to distribute

 Easy to analyze

Presenter
Presentation Notes
Brief Notes: We use Google Forms for informal assessments of our Library Instruction. We used to use paper, but now use Google Forms almost all of the time so we can save on paper, it is quick and easy to edit, easy to distribute – you simply generate a link for students and others to access – we use a link shortener like Bit.Ly to generate a friendly URL - and easy to export results for further analysis.



What are your learning outcomes?

The information you get from 
assessments should be what 
you need to have to determine 
if your learning outcomes were 
met.

Your learning outcomes can be 
written to reflect the Frames 
and their Knowledge Practices 
and Dispositions (or other 
standards as appropriate).

Presenter
Presentation Notes
Brief Notes: Before you design your assessment, whether it is formal or informal, you would want to think of your learning outcomes. You can write your learning outcomes to reflect the ACRL Framework and their Knowledge Practices and Dispositions, or the standard/s appropriate to your context.



What are your learning outcomes?

Student will carry out searches in a variety 
of library databases (GIL, GALILEO, etc.) 
in order to find resources for a research 
assignment. (Research as Inquiry; Searching as Strategic Exploration)

Student will decide whether a source is 
useful and appropriate for the assignment. 
(Scholarship as Conversation; Research as Inquiry; Information has Value)

1
2

Presenter
Presentation Notes
Brief Notes: For example, here are two learning outcomes we have used in a lot of our informal assessments. We are in the University System of Georgia and GALILEO is our discovery search system, and GIL is our catalog. Outcome 1 maps to the Frames of ‘Research as Inquiry’ and ‘Searching as Strategic Exploration’, and Outcome 2 maps to the Frames of ‘Scholarship as Conversation’, ‘Research as Inquiry’, and ‘Information has Value’.



Let’s look at our process…

Generally, our assessments:

 are process-oriented

 model behaviors

 ask open-ended or value-type questions

 include space for opinions and 
reflection

Presenter
Presentation Notes
Brief Notes: Our informal assessments tend to be process-oriented, i.e. we have the students to record their research process. We model behaviors – most of our library instruction is an explanation and demonstration, leaving 20 minutes or so for students to undertake the informal assessment, which we call a “Search Activity”. We use a combination of open-ended and value-type questions, and usually include space for their reflection on what they learned in the session and opinions to solicit feedback.




Some examples...

 English

 Communication

 Inquiry

 Education

Presenter
Presentation Notes
Brief Notes: We have four examples of informal assessments of our library instruction created using Google Forms to show you: one for a First-Year English course, for a Communication course, for a First-Year Inquiry course, which is an experiential learning type course where groups create their own question based on a theme to research, and an upper-division Education course. We will go live wherever possible, but have backup screenshots of these Forms just in case.



Example 1: 1st Year English

https://goo.gl/forms/CPTp5m7jQgYlvLVx1
https://goo.gl/forms/CPTp5m7jQgYlvLVx1


Example 1 cont. - 1st Year English



Example 2 - 1st Year Communication

https://goo.gl/forms/MtBjej3rz0yjXzZn2
https://goo.gl/forms/MtBjej3rz0yjXzZn2


Example 2 cont. - 1st Year Communication



Example 2 cont. - Communication



Example 2 cont. - Communication



Example 2 cont. - Communication



Example 3: 1st Year Inquiry



Example 3: 1st Year Inquiry



Example 3: 1st Year Inquiry



Example 4: Education (assignment)

Presenter
Presentation Notes
Brief Notes: For this informal assessment, students started working on it in class, and if they didn’t finish, then they completed it later for a completion grade.

https://goo.gl/forms/3rQAWycYbj4apB0l2
https://goo.gl/forms/3rQAWycYbj4apB0l2


Example 4: Education (assignment)



Example 4: Education (assignment)



Activity Time!

In groups, create two learning outcomes 
and a mini-assessment to test these 
outcomes using Google Forms.

Presenter
Presentation Notes
Brief Notes: In groups with at least one person who has a computer, use Google Forms to create two learning outcomes and a mini assessment to test these outcomes. It doesn’t need to be based on the ACRL Framework – you can make up whatever you want to assess.




Comparing and analyzing results…

You can:
 view at a glance typed answers, 

graphs, charts

 export your results to a Google Sheet 
or Excel Spreadsheet for further 
comparison and analysis 

 format your Google Sheet for 
readability when sharing

 enter your feedback – recent feature

Presenter
Presentation Notes
[Jo’s Section] Brief Notes: When I was undertaking informal assessment on paper before, I used to type up all of the answers into an Excel Spreadsheet for descriptive analysis. Once I became comfortable with using Google Forms for assessment, I rarely turn back as it is much more efficient – for one, it saves all that time from typing! The only time I use paper is when I undertake library instruction somewhere where I am unsure if students have access to computers or the internet. Furthermore, you can view at a glance the answers, and graphs and charts if you have asked a particular type of question that quantifies data, like a Likert Scale. You will see examples soon.  You can export your results to a Google Sheet for further comparison and analysis, and export to Excel for deeper analysis. I like to export results to Google Sheets because I can access them anywhere and it is quicker to format for readability when sharing. A recent feature is you can enter your feedback into Google Forms, which will appear in individual Form responses, however this won’t appear in the Google Sheet. So if you want to add feedback but prefer to use Google Sheets, enter your feedback directly into the Google Sheet you export.



Lets revisit: 1st Year English

Presenter
Presentation Notes
Lets go back to the 1st Year English assessment…

https://goo.gl/forms/CPTp5m7jQgYlvLVx1
https://goo.gl/forms/CPTp5m7jQgYlvLVx1


View responses - 1st Year English

Presenter
Presentation Notes
Brief Notes: For each question which requires a freehand text answer, Student One’s response for each question is in row 1, Student Two’s response is in row 2, and so on and so forth. The alternating shades of the rows make it easy to view at a glance. The question types that gather quantifiable data are automatically generated in a particular graph, for example, Likert Scale reports are generated in a column graph.



View responses - 1st Year Inquiry

Presenter
Presentation Notes
Brief Notes: For the First-Year Inquiry courses, students work in groups, so I had one group representative record the group answer.  Again, Group 1’s response is displayed in the first row for each question, Group 2’s in the second row, and so on and so forth. For a small data set like this, you can easily view at a glance the answers and see any glaring issues that groups might need follow-up support with, or to help you evaluate and improve on your own practice.  For example, for the second question, three out of four groups got the general idea of identifying keywords and/or key phrases, however I was concerned at the first group’s phrase of a brand name product only, and the third group’s long phrase, and next time want to reiterate further breaking up phrases into quite small chunks as that is a long exact phrase to search.


https://goo.gl/forms/Msz9h3FMuuJucz852
https://goo.gl/forms/Msz9h3FMuuJucz852


View responses - 1st Year Inquiry

Presenter
Presentation Notes
Brief Notes: We almost always give students a task to generate a citation for a source they might find useful, using a database’s citation generator. A flaw with Google Forms is that people cannot format their input, like italicize or indent. However, most of the time these citation generators are inaccurate anyway – and we always reinforce this to each class that to generate is a good starting point, but to cross-reference it against their citation guidelines and modify accordingly.




View responses - 1st Year Inquiry

Presenter
Presentation Notes
Brief Notes: I used to have these two questions combined before, but now I split them up into Multiple Choice and Free Text types, so that Google Forms generates a pie graph so I can view at a glance at how much of the class found a potentially useful source.



View responses - 1st Year Inquiry

Presenter
Presentation Notes
Brief Notes: We almost always include a reflective, minute-paper type of question to see what students learned during the session.  The more familiar you become with the ACRL Framework, you can start to automatically map what students learned to the Frames. For example, with the exception of the first group, all developed knowledge in “Searching as Strategic Exploration”. The first group recorded about what they learned in their research – even though I verbally instructed the class to record what they learned in the library instruction session. As mentioned earlier, viewing responses help you to evaluate your own practice - next time, I am going to make clear in the question that the reflection is for the session, to help cater to visual learners. 




View responses - 1st Year Inquiry

Presenter
Presentation Notes
Brief Notes: We almost always include a reflective, minute-paper type of question to see what students learned during the session.  The more familiar you become with the ACRL Framework, you can start to automatically map what students learned to the Frames. For example, with the exception of the first group, all developed knowledge in “Searching as Strategic Exploration”. The first group recorded about what they learned in their research – even though I verbally instructed the class to record what they learned in the library instruction session. As mentioned earlier, viewing responses help you to evaluate your own practice - next time, I am going to make clear in the question that the reflection is for the session, to help cater to visual learners. 




Create printouts - 1st Year INQR

Presenter
Presentation Notes
Brief Notes: On the ‘Individual Tab’ you can view each submitted Form one at a time, and print it out like a worksheet, with any feedback you entered.




Create spreadsheet - 1st Year INQR

Presenter
Presentation Notes
Brief Notes: But we prefer to export a summary into Google Sheets so we can quickly compare and contrast answers. To export the results into Google Sheets to compare and contrast all responses at once, select the Google Sheet icon which is the green square with the white cross. It will export all the responses into a Google Sheet.




Create spreadsheet - 1st Year English

Presenter
Presentation Notes
Brief Notes: This might not be necessary for a small dataset like the INQR class, but handy for a larger group, like the First-Year English class we had. The Timestamp column indicates when each student submits the form, giving us an idea on whether we gave them too much or too little time to spend on the task. Like Excel, you can hide columns. Here I have hid the column displaying students’ first and last names to protect privacy.




Create spreadsheet - 1st Year INQR

Presenter
Presentation Notes
Brief Notes: Here is an example of the First-Year Inquiry class. You can Share the results by selecting the blue SHARE button in the right hand corner. Selecting SHARE generates a link for you to share, and a few different options. More on that later…




Looks a bit 
messy, 
but…

Presenter
Presentation Notes
Brief Notes: … Because it looks rather messy for sharing with someone else to view the data, doesn’t it? Not pleasant to skim through the data.




Format your Google Sheet for sharing

You can:

 apply basic Excel functionalities, including 
‘wrap text’; adjust column width

 hide columns for privacy and  eliminate 
unnecessary data

 apply alternating colors with a click of a 
button

 add feedback comments in the same cell in a 
different font and color

Presenter
Presentation Notes
Brief Notes: You can quickly and easily format your Google Sheet so it is readable before sharing with students and faculty.




Lets spruce 
it up…

Presenter
Presentation Notes
Brief Notes: We gave the Google Sheets a makeover. You saw what ‘Before’ looks like, here are some “Afters’”. 




Formatted spreadsheet, eg. INQR 1000

Presenter
Presentation Notes
Brief Notes: Example of INQR 1000 responses in Google Sheet. You can set alternating colors and the click of a button – quicker than you can in Excel. In Excel you can Format as Table in alternating colors, but then you might want to revert back to the cell format. You can add comments in the same cell with different font, emphasis, and colors.



Formatted spreadsheet, eg. Comm 1101

Presenter
Presentation Notes
Brief Notes: Example of the Communication Class – with different alternating colors. Recently Google Forms added a new feature where you can add your feedback to the Form itself and it will export into the Sheet. 




Formatting a Google Sheet examle

Presenter
Presentation Notes
Brief Notes: I’ll do an example. Select all columns > Text Wrapping. Keep columns selected. Select paint bucket > Alternating Colors > Select desired. Select the alignment button to align the text in the cells to top, middle, or bottom. Double click to enter a cell. On your keyboard, hold the Alt key and press Enter/Return. Input my feedback. Select my feedback and change the font style and color.  Click and drag the columns to desired column width.




Further analysis with charts

If Google Form’s charts are insufficient for 
needs…

 download Google Sheet to 
Excel Spreadsheet and create 
charts using Excel

 create basic charts on Google 
Sheets  

Presenter
Presentation Notes
Brief Notes: At this stage, the descriptive analysis is enough for us. I screenshot the charts from the Google Form view if I want to show them at a Department Meeting. However, you can create basic charts on Google Sheets, or download the Google Sheet to Excel and create charts using the Excel function. I find the latter more user friendly and more functional than Google Sheets’ chart feature.




Example: Education webinars survey

Presenter
Presentation Notes
Brief Notes: For example, I was embedded in a few graduate education courses and provided webinar library instruction sessions for the first time over the summer. I wanted to gather feedback on it, and if the feedback was interesting, share results at the next department meeting. 

https://goo.gl/forms/yVTCkmhoz7rg2LNb2
https://goo.gl/forms/yVTCkmhoz7rg2LNb2


Example cont. – Education webinars

Presenter
Presentation Notes
Brief Notes: Select the vertical ellipses next to the Google Sheets symbol.




Example cont. – Education webinars

Presenter
Presentation Notes
Brief Notes: A range of other options will appear. Select ‘Download responses (.csv)’ and that will download a zip folder. Extract that, and it will open your results in an Excel spreadsheet.




Example cont. – Education webinars

Presenter
Presentation Notes
Brief Notes: We are quite happy with the charts that Google generates, but if you prefer to generate different charts, say you prefer a column graph over the Pie Graph Google generates for multiple choice questions, then you can create these in Excel. You can also do further types of analysis in Excel if you have suitable quantifiable data for it. 




Sharing results with faculty & students

view onlyGenerate 
sharable link 
and invite to…

Convert to PDF 
to email, embed 
in LMS, etc.

view and 
comment

collaborate

Presenter
Presentation Notes
Brief Notes: If you use Google Docs for sharing, you know what you can generate a sharable link and invite others to view only, view and comment, and collaborate. The same with Google Sheets. When you click on that blue SHARE button, it will generate a sharable link and give you the option for anyone with the link to view only, comment, or ‘edit’ allowing you to collaborate on the Google Sheet.  This is great if the faculty you work with like to use Google apps. Or you can download as a PDF to email, embed in an LMS, etc. There are other options as well, but these are the main two that we use.




Share link to view, eg. Literacy Education

Presenter
Presentation Notes
Brief Notes: When sharing the link for all students to view, I: Check with their professor first, hide the column of the students’ names, and set the SHARE setting to ‘View Only’. 


https://docs.google.com/spreadsheets/d/1_pp9DzPGxOtt96njpzJQ9s2e3voc6xhmFnWohDo_9jY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1_pp9DzPGxOtt96njpzJQ9s2e3voc6xhmFnWohDo_9jY/edit?usp=sharing


Share link for comment, eg. Literacy Ed.

Presenter
Presentation Notes
Brief Notes: Here is an example where I set the Google Sheet for ‘View and Comment’ so faculty and students can comment or question directly on the form and I would be directly notified via email. A flaw with Google Sheets is that it isn’t obvious that there is a comment from you explaining to students that they can and how to comment. You select this teeny gold triangle on the top right hand corner to view comments. So make it clear beforehand, eg. in an email or in an LMS announcement.




Convert to PDF, eg. Comm 1101

Presenter
Presentation Notes
Brief Notes:  Or you can convert to PDF and email it. With faculty and students not in my liaison area – where we are, all of the liaison librarians share library instruction of first and second year English and Communication courses – I typically download to PDF and share with the professor. 

https://docs.google.com/spreadsheets/d/1dRbIfb4YzZMbmfVmCqRBE30_xHjzZ2vKoCHKauE8Cqw/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1dRbIfb4YzZMbmfVmCqRBE30_xHjzZ2vKoCHKauE8Cqw/edit?usp=sharing


Convert to PDF, eg. INQR 1000

Presenter
Presentation Notes
Brief Notes: Another example. Converting to PDF is relatively simple. Once you are happy with the formatting, select the cells. Go to File > Download As > PDF document. Downloading as a PDF is just like printing the Google Sheet except it prints straight to PDF. The flaw with Google Sheets over Excel is that in Excel you can set Gridlines to show the print area and you can adjust your column widths accordingly so you can have what you want printed on the one page. In Google Sheets we are unaware of a way to do this and assume it doesn’t have this function. It can take a while to adjust the spreadsheet columns blindly so you can keep the content you want printed on each page. In Google Sheets, you can select the option to Fit to Width, Height, or Page, but if you have a lot of qualitative data, that will dramatically shrink your font size! It is better to adjust the spreadsheet columns yourself until you are happy with the printable/downloadable format. It is time consuming in the beginning, but with practice, you get to know what works for you it becomes quicker!



Convert to PDF, eg. INQR 1000



Downloading as PDF

Presenter
Presentation Notes
Brief Notes: Once you are happy with the formatting, select the cells. Go to File > Download As > PDF document > for the top option, Export, select ‘Selected cells’ > for the scale, select Normal (100%) > Select Export.

Downloading as a PDF is just like printing the Sheet except it prints straight to PDF. The flaw with Google Sheets over Excel is that in Excel you can set Gridlines to show the print area and you can adjust your column widths accordingly so you can have what you want printed on the one page. In Google Sheets we are unaware of a way to do this and assume it doesn’t have this function. It can take a while to adjust the spreadsheet columns blindly so you can keep the content you want printed on each page. In Google Sheets, you can select the option to Fit to Width, Height, or Page, but if you have a lot of qualitative data, that will dramatically shrink your font size! It is better to adjust the spreadsheet columns yourself until you are happy with the printable/downloadable format. It is time consuming in the beginning, but with practice, you get to know what works for you it becomes quicker!



Embed PDF in LMS, eg. Education Diversity

Presenter
Presentation Notes
Brief Notes:  These days I prefer to share PDFs rather than links to the Google Sheets themselves as I quite like how the PDF format looks, and students weren’t using the Google Sheet comment feature to comment. If you are embedded in an LMS,  the PDFs look user friendly to read embedded in the LMS, provided you set a decent font size and type. After checking with the class’s professor, I embedded the anonymous responses and made an announcement that I had included feedback and tips to the Search Activity they undertook in the Library Instruction session.




Activity Time!

In groups with at least one person who 
agreed to be added as a collaborator –
1. log into the Ice Breaker Survey
2. view the results
3. export into Google Sheets
4. play around with the formatting

Presenter
Presentation Notes
Brief Notes:  Form a group with at least one person who agreed to be added as a collaborator to our Ice Breaker survey. Collaborators would have received an email by now inviting them to collaborate on the survey. If you are the collaborator in the group, log into the Ice Breaker survey, and with the group: view the results; export into Google Sheets; and play around with the formatting.




Using Google Apps for Outreach Collaboration

Especially useful for signups:

 Google Docs and Google Sheets

 Digital access – shared link; one account for 
several applications

 Simultaneous users – instant updates to 
avoid any duplication or confusion

Presenter
Presentation Notes
[Jenn’s section – Jo presenting for Jenn] Brief Notes: Once you know Google Forms, Sheets for assessment, you will be fine for using them for other uses as well. We also use Google Apps for collaboration on outreach initiatives. We used to use Survey Monkey for surveying our colleagues’ opinions for events, but now use Google Forms as we don’t need to maintain another account. By having one account, we have access to several free applications – Google Drive, Docs, Forms, Sheets, etc.




Helpful Hints

 provide an overview and 
directions to avoid confusion

 don’t forget to change the use 
permissions of shared link to 
“anyone with link can edit” 
because the default is “anyone 
with link can view”

 be clear and direct

Presenter
Presentation Notes
Brief Notes: We use Google Docs for Sign Up sheets, so people can volunteer for different timeslots at outreach events, by inputting their availability. Google Docs is like a rather basic Microsoft Word.




Using Google Apps for Outreach Collaboration

Also useful for surveys:

 Google Forms 

 anonymous responses in a safe environment

 candid results

 able to use various question types

Presenter
Presentation Notes
Brief Notes: Google Forms allow you to survey your colleagues and gather anonymous responses, rather than asking for feedback at a team meeting. Jenn did this for our “Finals Frenzy” about the which involves a couple of weeks of de-stressing activities for students just before and during their Finals, such as coloring pages, therapy dogs, etc. Jenn received candid results of some rather constructive criticism of some events that she probably received in a discussion in our team meeting as I know these people! She shared the results anonymously.




Helpful Hints

 use appropriate question types like you would when 
assessing instruction

 when sending surveys to people, use the blind copy 
function to protect anonymity

 can use Google Sheets to export responses

 always send out survey results to respondents without 
editing (unless wildly inappropriate). It’s important that 
respondents are heard and taken into consideration; 
editing negates that



Helpful Hints

Example: For determining people’s 
preferences, use a Likert-scale type 
question

Example: For determining people’s 
schedules, use closed-ended 
questions

Presenter
Presentation Notes
Brief Notes: Use appropriate question types to easily evaluate responses. For example, I am on the Marketing and Finals Frenzy Committees, and Jenn sent us these surveys of various question types to indicate our preferences.




A final word…

 although we are breaking it up from it, we 
would happily set it up with a friend

 like all free apps, it has limited functionality, 
however…

 its features and functionality continuously is 
improving

Presenter
Presentation Notes
Brief Notes: Like all free apps, Google Apps has pros and cons. However its features and functionality is continuously improving, like you can enter individual feedback which will show up on the Individual Response pages. Even though we are phasing out of Google Apps because of the LibWizard acquisition, we continue to use it for our personal uses and would happily recommend it to a friend.




Questions? 
Comments? 
Concerns?
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